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1. Initial Setup 
 
1.1 Copying Drawing Formats 
Create a folder for a copy of the setup files on your machine in a location such as \program files\PCAD 
2002\pcb formats. Now, let’s copy the provided format setup files to your machine for your use. Double 
click on “group on jlabgrp” (typically your M drive). Find the folder EECAD and double click, find PCAD 
and double click, then PCB Formats. Copy all three folders to your machine. Most likely you will primarily 
use the full size formats for your work. The half size formats were created to allow us to plot our PCB 
documentation at twice scale but that is rarely done these days. The board out lines folder contains 
commonly used PCB board outlines complete with targets, layer nomenclature and dimensioning. 
 
 
2. Starting your PCB 
 
2.1 Open a setup drawing 
Okay, let’s start a PCB. Open the PCAD PCB editor. The first thing to do is open a setup file. Select File 
OPEN and find your drawing setups directory. Select the size you think will be appropriate to contain your 
PCB. The setups correspond to the following sizes: 
 
B_?lyr_g is 11” x 17” 
C_?lyr_g is 17” x 22” 
D_?lyr_g is 22” x 34” 
E_?lyr_g is 34” x 44” 
 

We recommend that you use B (preferred) or C size. B size sheets can 
be printed on almost any printer here and still be very legible. 3U 
cards will fit on a B, while 6U will fit on a C. For backplanes, you 
may have to use a D size. 
 

The names above contain a ? to represent the number of layers. This is why we have multiple setups for 
each size. Each format has been structured to have print & gerber setups for the corresponding number of 
layers. It is in your best interest to start your PCB with one of these setups. They will save you a LOT of 
work later on. 
 
Click File-Save AS and save this file as a different name into a different directory. We suggest that you 
make a separate folder for each project you work on and that you name the file with a descriptive name. 
Please don’t call it PCB. A more appropriate name would include system and function, like BPM mux.pcb. 
A project directory might look something like this: 
 

 
 
We suggest that you store your work in an area that gets backed up regularly. The EECAD group has a 
common area for file storage and would be glad to provide you with your own directory to store your 
projects in. Contact Lori @ 7332 or beckett@jlab.org if you’d like some space in this area. 
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2.2 Environment setup 
Now let’s make sure everything is as it should be.  
 
Open the View menu pull down.  

 

 
Verify that Snap to Grid has a check mark next to it. If not, click 
on it to make it active.  
 
 
If you only remember a few things from this document, this is 
probably the MOST important thing to remember. If you don’t 
snap to grid, it will be very difficult to connect your components 
and to make changes later.

 
Verify that your Grid is set to 50 mils. Look at the very bottom of your editor window. The third box from 
the left that has numbers in it is your grid size. If this does not say 50, click the arrow to the right of the 
number and select 50 from the pull down. Your grid may need to be set lower if you are placing SMDs. A 
typical grid in this case might be 5 mils. 
 
Next, click on Options-Display 
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Here you can control & 
change the colors your PCB is 
displayed in. Some people, 
like myself, might not like red 
& green for Top & Bottom. 
Using this you can change 
your color options for just 
about anything. 

 

 

The Miscellaneous tab allows 
further control of how & 
what’s displayed. If working 
with SMDs, you might choose 
to Hide Glue Dots and Pick 
and Place indicators. You can 
also change your cursor style 
here or through the keyboard 
by using the X key.

 
3. Moving around in the editor window 
 
3.1 Zooming 
One of the easiest methods of zooming in and out of your drawing is with the PLUS and MINUS keys on 
your keyboard. 
You can also zoom in or out by going to the View menu and selecting either Zoom in or Zoom Out, then 
clicking on the area you want to zoom from or to. 
You also have the option to do a Zoom Window by either selecting it from the View menu of clicking on 

the    button. Then Left click and drag a window around the area you want to zoom in to. 
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3.2 Panning or moving 
You can use the scroll bars on the right or bottom to pan across your drawing. Or you can move your cursor 
to an area and hit the “C” key. This re-centers the view with your cursor location at the center of the 
window. 
 
4. Starting your PCB 
 
4.1 Design Info 
Using the PLUS key, zoom in to your title block area.  
 

 

 
 
Here you can see the numerous 
FIELDS that have been placed 
in the title block. They look like 
this {Title}. These Fields can 
only be edited through the 
FILE- Design Info selection 
which we will select now.

 
 

 
 

Double click on the value box for 
the Field you wish to modify to 
open the dialog box. The 
following Fields will need to be 
modified: 
Date 
Drawing Number 
Drawn by 
Engineer 
Revision 
Additionally, you need to edit the 
text that says Major System, Sub 
System, Component Designation 
and the path strings that indicate 
where this drawing is stored. The 
EECAD group will be glad to 
help you with naming your 
drawing if you’re unsure how to 
do this. We are also the ones that 
you would call for drawing 
numbers (or you can wait if you 
plan to submit your design to us). 
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5. Laying out your PCB 
 
A good PCB layout has… 
 
 components oriented in only two of the four possible directions (exceptions can be made) 
 components placed at 0 or 90 degrees (no components shall be placed at 45 degrees!) 
 uniform and generous component spacing, if possible  

(remember they have to be built & worked on) 
 all the components lying flat (no antennas!) 
 filter caps placed next to the power pins on their associated ICs. 
 pull up/down resistors located adjacent to their associated component 
 a minimum trace width spacing between parallel traces equal to or greater than the width of the 

traces 
 internal power/ground planes or decent width on the power & ground traces 
  (no 10 or 15 mil traces here! 25-30 mils or greater if possible) 
 the voltages run to the filter caps, then to the IC. 
 in the event of internal planes, the power strap on filter caps then a trace run to the IC 
 planes backed off from the edge of the board (50 mils minimum) 
 pin one indicators for ICs, connectors and sips 
 same style pads for like components  

(all ICs should have the same shape pads, i.e. round & square or oblong & rectangular) 
 the name, drawing number and revision level silk screened onto the board 
 no fonts below 60 mils on the silkscreen (font should be relative to board density) 
 
5.1 Placing your Board outline 
Before you can read in your netlist information to start your board, you need to place a board outline in 
your workspace. We have a number of common ones available, which you should’ve copied to your 
computer in an earlier step. We will talk about copying one of these existing outlines into a format and 
creating an outline from scratch. 
 

Existing outlines 
Since you opened a setup & saved it in an earlier example, we’ll assume you still have that open. Now open 
one of the board outlines in the board outlines folder. Make sure your grid is set to either 50 or 100 mils. 
Click on the Edit pull down menu and click on Select All. Right Click and click on Copy. Click on the 
Window menu pull down and switch to your saved format. Make sure the grid here is set to either 50 or 
100 mils. Click on the Paste icon and click and drag within your window area to place the copied outline. 
 

Creating an outline from scratch 
Maybe one of the existing outlines doesn’t suit your needs because you’re making a board to fit into a 
special enclosure. Here is what you do to create your special board outline.  
 
 

 

 
From the layer pull down at the bottom of your 
design window, select the Board layer to make it 
current. 
Verify that your grid size is set to 100 mils. 
(Unless you have an odd , tight area that you are 
fitting this board into, try to keep the size of your 
board defined to one decimal place. i.e. 5.5 
instead of 5.475) 
Make sure your line width is set to 10 mils.
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Select Place- Line and draw the outline of your PCB. If you look to the lower right of your editor window, 
you will notice a line of changing text that will read something like this: 
 

  
This shows that your orthogonal snap is set to any, you have traveled 500 mils in the X (horizontal) and 
200 in the Y (Vertical). This can be very helpful in drawing lines of certain lengths. One important item to 
keep in mind, your board outline must be closed.   
 
Once you have your outline drawn, you need to think about how the board will be mounted in the 
enclosure. Most likely, you will need to add mounting holes to your board so the board can be mounted in 
some fashion, for example on stand offs. If it is a small board, typically you’d want to add three to four 
holes for mounting. For larger boards, you would want to add additional mounting to support the board and 
prevent sagging, warping or flexing. Go to Options- Pad style to select a mounting hole. Your selection 
will depend on what size hardware you choose to mount your board with and whether or not you want your 
mounting holes grounded. For no grounding, select a pad style defined as the same size as the mounting 
hole such as P:MX110Y110D110A. If you intend to ground, select a pad style that is bigger than the hole 
size, such as P:MX150Y150D110A. Double click on the pad style you choose to make it current. Then 
from the left hand toolbar, click on Place- Pad and place pads for your mounting holes.  
 
Add your targets by opening one of the existing board outlines and copying a target from it into your 
current drawing. Do likewise for the text located under the board outline. (These will be used later to label 
your Gerber layers.) 
 

Now, you need to dimension your outline. Click on the Dimension button.  
 

 
 

Click on the Layer selector and 
change it to Fab. Click on 
Precision and change that to 2.  
Change your Text Style to 
something appropriate to the size of 
the format. For a B size, this should 
be T:H120Y10. Since our 
Orientation is set to Horizontal, 
this is where we’ll start. Click OK, 
then select the left side of your 
board outline. Now, click on the 
mounting hole you placed earlier 
that is the closest to the lower left 
hand corner of the board, Click & 
drag to place your dimension and 
locate the text. (Play with locations 
as you drag to get a feel for how it 
looks and behaves.) Next place a 
dimension for the overall board 
width by clicking on the left outline 
and the right outline. Right click, 
then left click to bring up the 
Place- Dimension menu again. 
Change the Orientation to Vertical 
and click OK. Now, place the 
vertical dimension for the mounting 
hole and for the board height. 

When you’re done, you should have something that looks like this: 
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You should always dimension height and width plus the location of one hole, typically located close to the 
lower left corner of the board. 
 
Now that we have our board outline defined, it’s time to read in our netlist. 
 
5.2 Reading in the Netlist file 
If you worked through the schematic handout, you’ll recall that towards the end of it we generated a netlist 
from our schematic. The netlist contains all the point to point connection information along with the 
component information. We will now read that schematic into our PCB drawing.  

Library setup 
The first thing you need to do is open the library file or files that correspond to your PCB. Hopefully you 
have followed the steps detailed in “Getting Started in the Schematic Editor” for archiving a library for 
your project. Select Library-Setup-Add and find the library you created earlier for the board you are 
getting ready to start. 

Workspace size 
Your overall workspace size will need to be increased briefly. Please remember to change it back once you 
get all your components relocated within your PCB outline. Click on Options- Configure and double the 
size of the height of your workspace. 

The netlist 
To read in your netlist, click on Utils- Load Netlist. A dialog box will appear. Verify that the netlist format 
is the same as what you generated in and that the name of the netlist file is correct, then click OK. If you 
are working with formats that were built for PCBs with greater than 2 layers, you will be prompted during 
the load to assign nets to certain internal planes. This would be were you tell the system which voltages are 
placed internal. If there are no problems, your components will be placed at the top of your format with 
“ratsnets” (rubberband or connection) lines indicating the net connections. It will look similar to this: 
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5.3 Component placement 
Usually at this point I try to move all my components so that they are within the drawing borders but still 
outside the PCB outline. Then I set my workspace size back to normal. 
 
Okay, now comes the time to place your components within your PCB. This can be done a number of 
ways.  
The first way is the old-fashioned and perhaps the hardest way. Sitting down with the schematic in front of 
you and hunting for your parts, clicking on them and dragging them to where you want to place them. This 
can be rather time consuming, so we recommend one of the following three ways. 
The second way, is to open your schematic in the schematic editor and select the portion of circuit you wish 
to place by doing a selection window. Right click and select Highlight. Now, return to the PCB and those 
components will be highlighted and you can select & place them where you wish. Return to the schematic 
and Unhighlight the components you just placed. Then select and highlight the next set of components you 
wish to place. Continue this process until all components are placed. 
 

 

 
 
The third way, is through Edit- Move by 
RefDes 
Highlight the component you wish to 
move and click OK. Or click Select All 
and it will allow you to place each 
component in order without having to 
restart this command each time
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.
The fourth way is though an interactive placement tool called InterPlace. It can be accessed through Utils-
P-CAD InterPlace/PCS, which will open a new window: Click on File- Load PCB Design and notice how 
the windows all change. 
 
 

 
 

As you can see, it has loaded a 
simple version of your PCB outline 
& components into one window. The 
window on the right is a listing of all 
the components by Reference 
designator and also includes type and 
value information (which helps in 
finding all those filter caps). You can 
click and drag from the listing into 
the window with the PCB outline to 
place your components. You can 
access additional information 
through this right hand window. If 
you click the second tab there on the 
bottom, it brings up a listing of all 
the nets. With this you can turn them 
on, off or highlight them. Having 
your signal nets on helps greatly with 
placement.

 

 

 
You’ll notice that we have additional 
information in the bottom two 
windows. This allows you to view 
things like DRC by layer (as shown 
here), net constraints, net classes and 
additional component information. 
 
You can also combine the second 
method with this method if you find 
that helpful. 
 
Once you finish placing your 
components, you will have to update 
your PCB and close this window. 
Click on File- Update PCB, then 
File- Close.

 
 
Remember that when placing components, you can use your “R” key to rotate and the “F” key to flip. 
Please keep in mind that if you flip a component in the PCB editor that it physically moves from the top 
side to the bottom side of the board. 
 
 
5.4 Setting up DRC 
Before you route your board, you need to set up your design rules. Select Options- Design Rules to open 
the dialog window. There are two tabs that should be reviewed by all users. The first is the Design tab. 
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Here is where 
you would 
define your 
rules for 
Silkscreen 
clearance, 
general hole to 
hole clearance 
and board edge 
clearance. If 
your board 
looks to be a 
tight board, you 
will want to set 
your Silkscreen 
clearance 
much, much 
lower to 
prevent DRC 
from flagging 
every piece of 
silkscreening.
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The Layer Tab lets you define your design rules per layer. For example, maybe you have SMD RF 
components on the top and wish the pad to pad and pad to via clearance to be greater than on the bottom. 
You would change those values and click Update. 
 
Click Close, then click the DRC icon to make DRC active. 
 
5.5 Routing the board 
As with placement, there are numerous ways to route your board. The first is to route it manually. Some 
boards have to be routed manually, controlled impedance boards for example. This method is more time 
consuming, but for a seasoned designer it will result in a cleaner, better route. A seasoned designer can, in 
most cases, manually route a board in less time than it would take to Auto-route and clean up. (You should 
always clean up an autorouted board.) You can use Highlight Net and control the display of the nets to help 
you with your routing. You may also choose to manually route certain nets before turning one of the Auto-
routers loose on your board. 
 
While routing, hitting the L key will cycle through your layers. The G key will cycle through your grids. 
Pressing the O key cycles through orthogonal modes (allowing you to snap your traces @ 45 or 90 degrees) 
Backspace will undo your last mouse click when routing traces.  
 
Interactive Routing is similar to manual with the exception that you don’t have to pick every corner of 
every segment like you do with manual route. In Interactive, you select your net and it will automatically 
place bends and corners in as you stretch your trace closer to its destination. 

Four Routing Tools 
There are four routing tools we will quickly discuss before moving on to talk about the auto routers.  

1. The Route- Miter tool. converts 90-degree corners on routed connections into 45-degree mitered 
corners or 90-degree arcs. The 90-degree corner must be true horizontal and vertical segments and 
have the same line width.  

2. The Route- Bus tool allows you to specify several connections to be guided simultaneously as a 
bus. 

3. The Route- MultiTrace tool is designed to automatically route several connections. In contrast to 
Bus Route, MultiTrace routes each connection individually allowing each trace to find its 
optimum path.  

4. The Route- Fanout tool is used for the systematic placement of traces from a PCB component. 
These traces can then be used by Route Bus as a start or termination point. This can be extremely 
helpful on surface mount devices. 

 
5.6 Autorouting 
When you choose the Route- Autorouters command, the Route Autorouters dialog appears. The Route 
Autorouters dialog lets you choose the autorouter you want to use to route your designs and to set 
autorouter options for the selected autorouter. You can also start and restart the autorouting process from 
this dialog. Each router has different parameters that can be manipulated. As with anything, time & 
experience will help you to configure these routers for top performance. 
 
Quick Route- this is the default router. It is a very basic, down & dirty router that will get your 
connections from point A to point B with straight vertical connections and plenty of vias. If you have a 
simple board to route, we would recommend doing it manually/interactively as opposed to using this router. 
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As you can see, 
the results can 
be rather ugly 
and leave you 
scratching your 
head. This route 
requires much 
cleanup on the 
part of the 
designer. Quick 
Route also has 
the lowest 
completion rate 
from my 
experience with 
it.

 
 
P-CAD Shape Route- is an easy to use, powerful, high quality, shape based autorouter. Based on the latest 
in routing algorithms, P-CAD’s Shape-Based Router uses polygonal shapes to provide virtual gridless 
autorouting (similar to Specctra) and the ability to specify different routing angles for each layer of your 
PCB design. 
Optimized for today's dense SMT-based designs, P-CAD's autorouter easily handles mixed metric and 
imperial pin spacings and double-sided component placements. Since it is a more complex router, there are 
many more variables that can be changed prior to routing. This router will route cleaner than Quick Route 
with fewer vias. The major drawback to this router comes when doing an ECO. It can be more time 
consuming to make changes to a board routed “gridless” than if you routed the board on a 25 mil grid. If 
you want to use an autorouter, this is the one we recommend and we will touch on a few important things 
to do to get optimum results. If the board includes routing that you do not want the router to rip up, make 
sure the traces involved are fixed, using the Edit- Fix command in the PCB Editor. These manual traces 
can include fully routed nets, nets with some of the connections routed, and nets with partially routed 
connections, such as fan outs and breakout routing. 
When you start this router, it will open a new window. Select Options- Autorouter to make parameter 
changes. It is important to note that the Router analyzes your board database during loading and 
automatically set up the routing parameters and the routing passes. We recommend using the selected 
parameters and routing passes unless you have a specific reason to change them. 
 
Prior to Routing- 

Perform a Pre-Route Synopsis prior to starting the autorouter.  
Use the Density Map feature to check for areas of the board that may prove difficult to route.  

Both features are found under the Reports pull down.  
 
To start autorouting select Tools Start Autorouter. The cursor will change to an hourglass, indicating that 
routing is in progress. The Status Line at the bottom of the display provides real time status on the routing 
progress.  
The first stage of the autorouting process is analyzing the board and selecting a suitable routing strategy. 
The routing strategy is selected to suit the device technology used on the board and the routing parameters 
that have been defined. The strategy will automatically select and schedule the various routing passes, the 
active routing pass is shown on the status line. If there are any problems detected during the initial analysis 
the router will stop and a message will be displayed. 
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This is the same section 
of the board that was 
routed earlier with Quick 
Route. You can see that 
this route is much 
cleaner, has a minimal 
number of vias and was 
routed completely. Plus 
it was routed in about 20 
seconds. You will still 
need to review the 
routed traces as there 
will probably be a few 
areas in need of clean 
up.

 
At this time, we do not have licensing for either of the Pro routers. The only current license for the Specctra 
router is held by the Fast Electronics Group. They can be contacted to set up a time to route your board 
should you need to use the Specctra router. They can also advise you on how to set up your “Do” (route 
parameters) file. 
 
 

6. Post processing (or checking your work) 
 
6.1 Design Rules Check 
Okay, so you’ve routed your board, what now? Well, the first place to start is to check your work. We use 
Design Rule Checking for this. Select Utils- DRC.  
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For the most part, it doesn’t hurt to check everything under the Design Rules Checks section. You can turn 
off Copper pour violations and Plane Violations if you don’t have either, but it doesn’t hurt to leave them 
on. Please make sure you are doing a Netlist Compare. This will verify that the netlist you ran off of the 
schematic matches the routed board. Also, please make sure to run Unrouted Nets. This will flag anything 
you may have forgotten to route. Clearance Violations is also an important one as it will flag any clearance 
violations you may have between your traces. If you check the Annotate Errors box, DRC will place little 
indicator symbols to indicate the locations where it found problems. If you click on any of these symbols, it 
will open a box that will detail the problem. Fix your problems and continue to run DRC until it comes up 
clean. 
Now that the board has been checked and any errors cleaned up, we have a few things left to do before we 
can generate gerber. 
 
6.2 Board Identifiers 
First thing is you need to add text to your board  

Make sure your active layer is set to Top Silk then click on the Place Text icon.  
 

 
 
 

Try to use a decent size 
font so that your text 
stands out from the 
Reference Designators 
on the board. You want 
to type in the name of 
the board, possibly 
proceeded by the system 
or sub-system, the 
drawing number and the 
revision level. Place this 
is an open area on your 
board taking care to 
avoid pads & holes if 
possible.

6.3 Internal Plane borders 
If you have internal plane layers and haven’t done so already, add a 50 to 100 mil line around the edge of 
the board to prevent your plane from running all the way up to the edge and possibly shorting to other 
planes. 
 
6.4 Gerber file labels 
Next, we need to update the text we copied & placed underneath our board outline. An example piece of 
text might be: Solder Side (XXXXX.BOT) DWG # REV -. Update the text in the parenthesis with the 
name of your PCB file, (B9999P1.BOT). Change DWG # to reflect the artwork number of the board and 
update the revision level if appropriate. These lines of text will label your Gerber data and help you and the 
board house know what’s what. 
 
6.5 Fabrication drawing 
Next we need to complete our formatting for our fabrication drawing. We do this now because this drawing 
will be one of the Gerber files we send to the board house.  
First, we need to update the notes. Double click on the notes on the right hand side of the drawing to select 
and edit them. Note three should be updated if you are making a backplane (either .093 or .125) or if there 
is a special need to have it a different thickness. In most cases, leave it at .063. Next, update note four if 
you desire more or less copper thickness. 1/2 to 1 oz is pretty common. Use 2oz if yours is a high voltage 
board. If you have components on both sides, you will need to update note seven to reflect that. Note nine 
should be updated with the name of the board and the drawing number for the artwork. Click OK to finish 
editing. Now we need to place our drill table. There are two ways to do this. One uses a utility program. 
The other is through Document tool box and since it is the easiest method we will discuss it. First off, we 
need to assign symbols to our various hole sizes. We do this by clicking on the printer icon, then selecting 
the Drill Symbols button. Click on the Automatic Assign button, click Close and Close. Click on the 
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DocTool menu and select Place Table. Select Drill Table and define your line width (10 is fine) and your 
text font (125 or 100 if you have a large number of different size holes). Clicking the Advanced button will 
preview your table so you can make changes prior to placement. Add a column for TOLERANCE. Don’t 
worry about the width as you can adjust it physically in the table. Enter +/-.003 for all sizes less than .055. 
+/-.004 for all sizes .055 to .124 and +/-.005 for all sizes over .125. Use your arrow keys to move from row 
to row. Do not hit ENTER! This will place your table and we don’t want to do that until we’re done adding 
our tolerances. Hit Enter or click OK to place your table once you have added all your tolerances.  
 
6.6 Assembly drawing 
Update the notes for the assembly drawing by clicking on the notes located at the bottom of the drawing. 
Add the schematic drawing number to note one in place of the xxxxs. 
 
7. Generating Gerber and NC Drill files 
 
7.1 NC Drill file 
Before we generate our Gerber, we’ll generate our NC Drill file. This is the file the board house uses to 
drill your board with. Click on File- Export- N/C Drill  
 

 

 
Click on Tools…and 
click Auto to auto-
assign tools to your hole 
sizes. Click N/C Drill 
Format and make sure 
the following are 
selected: Inches, ASCII 
None and Leading, click 
Close. Click on Setup 
Output Files and make 
sure to change your 
output path to the 
directory that your board 
lives in. (Ultimately, it 
would be great to write 
this & the gerber files 
into a directory within 
your board directory 
called Gerber.) Now, 
click on Generate 
Output Files to generate 
your file. 

 
7.2 Generating Gerber files 
Okay. We’ve done all our prep work & now’s the time to generate the all important Gerber files. These are 
the files the board house will make your board from. We generate these files in RS-274X which embeds the 
aperture information in the file so there is no need to generate a separate aperture list. Select File- Export- 
Gerber 
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The first thing to do is 
assign aperture, so click 
on Apertures and click 
Auto and Close. Next 
click Gerber Format 
make sure the output is 
in Inches and that the 
RS-274X box is 
checked. Make sure that 
the file listing is correct 
for your layer 
stackup/board 
configuration. If not, 
Click on Setup Output 
Files to modify it. 
You can also elect to 
automatically load your 
Gerber into Camtastic 
by checking the box as I 
have here. Camtastic is 
the tool we use to check 
our Gerber data. It is 
highly recommended 
that you check your 
files. 

 
 
Take a deep breath, and click Generate Output Files.  
 
Once it is done, a Camtastic window will open displaying your Gerber files. Uncheck the check boxes next 
to each layer then start turning individual layers on until you have reviewed them all. If everything looks 
good, then we now move to the read me file that you will include in your zip file. 
 
 
7.3 The Read Me file 
It is recommended that you include a read me file with the data you send to the board house. A template 
can be found at \\jlabgrp\eecad\pcad\templates. Update it to the requirements of your board. There are a 
number of items in italics that you need to update such as board name, physical size, total number of holes, 
your name & contact information, etc. 
 
Create a ZIP file containing the N/C drill file, your Gerber files and the read me file. Name it something 
descriptive like the name of the board & revision level so you & the board house know what it is. 
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8. Printing 
Printing in the PCB editor is very similar but there is one major difference from the schematic editor. You 
can set up Print Jobs in the PCB editor for things you would always want to print, like your assembly 
drawing for example.  
 

 

 
We have multiple Print jobs set up in the JLAB 
supplied formats to save you the time & trouble of 
doing it. We have jobs set up for our standard 
outputs, fabrication, artwork & assembly drawings. 
The last two may have to be modified based on your 
board configuration. 
 
Some people question the value of hard copy fab & 
artwork files. These drawings have been used to help 
re-create boards that have had their files either lost or 
destroyed. The artwork file can also be helpful if you 
need to modify an existing board. Fab drawings can 
be used by our buyers to get quotes. So, you see there 
are many reasons to create hard copies of these files. 
 
Assembly2 is for your BOM unless you have a board 
with components on both sides. If that’s the case, 
copy sheet 2 to sheet 3 and make sheet 2 the view of 
the bottom side components. I have written a 
procedure to help you create a view of your PCB 
from the bottom so that it will print out correctly. See 
the instructions below.

 
 
8.1 Setting up and Plotting a mirrored bottom assembly view 
 

1. Under OPTIONS- DISPLAY change the following: 
a. Uncheck the Display Plane Indicators box 
b. Uncheck the Display Pad Holes box 
c. Click the Hide button for Glue Dots and Pick & Place 

 
2. Turn off all the layers not associated with the view you want to create, in this case everything 

except BOARD, BOT ASSY, BOT SILK and your format layers. Make BOT ASSY your current 
layer. 

3. Under DOCTOOL, make sure Mirror On Copy is checked by selecting it. 
4. Click & drag a window to select your board including the board outline. 
5. Select EDIT- COPY 
6. Select EDIT- PASTE Special then click OK to accept the choice. 
7. Place your mirrored assembly view pretty much over the existing view. 
8. Set up a print job for this view (should be sheet two of your assembly moving the BOM to sheet 

three). This view would include the following layers: BOT ASSY, BORDER and TITLE. 
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9. PCB layout start to finish 
 
1. Create a directory for your new project (on a drive that gets backed up regularly) 
2. Open a JLAB format 
3. Save the opened format into your new project directory giving it a new & descriptive name 
4. Update title block information 
5. Copy in an existing board outline or draw a new one 
6. Increase the size of your workspace 
7. Associate the libraries you wish to use using Library-Setup 
8. Load your netlist 
9. Place your components within your board outline 
10. Route your board 
11. Run Design Rule Check 
12. Place your identifying text on the silkscreen layer  
13. Add plane layer borders if applicable 
14. Update labels for gerber  
15. Update fab and assembly drawing notes  
16. Place Drill symbol table 
17. Generate N/C Drill file 
18. Generate Gerber files 
19. Update Read Me file 
20. Create a Zip file of the N/C drill file, Gerber files and the Read Me file. 
21. Plot vellums for signatures 
 
10. Tips, Tricks & Hot Keys 
 
While in the Edit mode: 
•  Shift-Left click allows you to sub select any portion of a part. 
• CTRL-Left click & drag allows you to copy & paste the object. 
• Once an object is selected, Right Click brings up a sub-selection menu. 
• Left click- delete to delete an object. 
 
C- re-centers your View window to where you have your cursor located. 
+- Zoom In  
-- Zoom Out 
X- changes the style of cursor you see 
U- Undo 
O- cycles through orthogonal modes 
R-rotates components or sub-selected text 
F- flips components or sub-selected text to the opposite side of the board 
G- cycle through your grids 
W- cycle through your line widths 
M- starts the Macro recorder 
E- plays a temporary Macro 
Z- activates the Zoom Window (Remember, when using a window to select, left click and DRAG to draw 
your box.) 
Backspace- undo your last mouse click when placing wires.  
Shift +Select- allows you to sub-select component text so you can move & rotate it independent of the 
component. 
F1- Help menus. 
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11. General Rules & Guidelines 
Grid size should be set to 100 or 50 mils for parts placement & 25 mils for routing; 5 mils is acceptable for 
placing & routing surface mount components. 
 
Components should be oriented vertically or horizontally, NEVER diagonally. 
 
Filter caps placed adjacent to the power pin on the IC. 
 
Voltages routed to the filter caps first, then to the IC. 
 
Traces should be kept as short as possible. 
 
Spacing between traces should be equal to or greater then the trace width. 
 
Internal planes backed off from the edge of the board. 
 
Pin one indicators for ICs, connectors and sips included on silkscreen. 
 
The name of the board, base drawing number and revision level included on the silkscreen And should be 
larger than the reference designators. 
 
Reference designator fonts should be legible and as large as possible. Try to use a font that is 90 to 100 
mils tall unless your board is very dense. Then, no smaller than 60 mils. 
 
Silkscreen orientation should always be either 0 or 90 (right reading) degrees. 
 
Silkscreen should never cover a hole or pad. 
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